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WinRiver II Section-By-Section User's Guide 
 

1 Introduction 
WinRiver II Section-By-Section (SxS) is Teledyne RD Instrument’s (TRDI) 
real-time discharge data collection program.  This program creates a meas-
urement file to operate the ADCP, checks each command, and verifies that 
the ADCP has received the commands.   

Making accurate discharge measurements is less difficult than you probably 
believe now.  You will soon see that you need to use only a few keystrokes 
on the computer to collect data in the field.   

Please take the time to read this entire manual.  It will be useful to have the 
ADCP and a computer available to follow along.  You may also want to 
keep the other ADCP Technical manuals handy for reference when you 
want more detail. 

 
NOTE.  This guide covers WinRiver II Section-By-Section version 2.01. 

 

1.1 How to Contact Teledyne RD Instruments 
If you have technical issues or questions involving a specific application or 
deployment with your instrument, contact our Field Service group:  
Teledyne RD Instruments  Teledyne RD Instruments Europe 

14020 Stowe Drive 
Poway, California 92064 

 2A Les Nertieres 
5 Avenue Hector Pintus 
06610 La Gaude, France 

Phone +1 (858) 842-2600  Phone +33(0) 492-110-930 

FAX +1 (858) 842-2822  FAX +33(0) 492-110-931 

Sales – rdisales@teledyne.com  Sales – rdie@teledyne.com 

Field Service – rdifs@teledyne.com  Field Service – rdiefs@teledyne.com 

Customer Service Administration – rdicsadmin@teledyne.com  
Web: http://www.rdinstruments.com 

24/7 Technical Support +1 (858) 842-2700 
 

mailto:rdisales@teledyne.com
mailto:rdie@teledyne.com
mailto:rdifs@teledyne.com
mailto:rdiefs@teledyne.com
mailto:rdicsadmin@teledyne.com
http://www.rdinstruments.com/
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1.2 Conventions Used in this Guide 
Conventions used in the WinRiver II SxS User’s Guide have been estab-
lished to help you learn how to use these programs quickly and easily. 

Windows menu items are printed in bold: File menu, Save Measurement.  
Items that need to be typed by the user or keys to press will be shown as 
<F1>.  If a key combination were joined with a plus sign (<ALT+F>), you would 
press and hold the first key while you press the second key.  Words printed 
in italics include program names (BBTalk) and file names 
(Test_000_000.PD0). 

Code or sample files are printed using a fixed font.  Here is an example: 
WorkHorse Broadband ADCP Version X.XX 
RD INSTRUMENTS (c) 1996-2006 
ALL RIGHTS RESERVED 
> 
 

You will find three other visual aids that help you: Notes, Cautions, and 
Recommended Settings. 

 

NOTE.  This paragraph format indicates additional information that may 
help you avoid problems or that should be considered in using the 
described features. 

 

 

CAUTION.  This paragraph format warns the reader of hazardous 
procedures (for example, activities that may cause loss of data or damage to 
the ADCP). 

 

 
Recommended Setting.  This paragraph format indicates additional 
information that may help you set command parameters. 

 

1.3 Software Requirements 
WinRiver II SxS requires the following: 

• Windows XP Pro® or Windows 2000®   
• Pentium III 600 MHz class PC (higher recommended) 
• 64 megabytes of RAM (128 MB RAM recommended) 
• 50 MB Free Disk Space plus space for data files (A large, fast 

hard disk is recommended) 
• One Serial Port (two or more High Speed UART Serial Ports rec-

ommended) 
• Minimum display resolution of 1024 x 768 
• CD-ROM Drive 
• Mouse or other pointing device 
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1.4 Software Installation 
To install WinRiver II SxS, do the following. 

a. Insert the compact disc into your CD-ROM drive and then follow the 
browser instructions on your screen.  If the browser does not appear, 
complete Steps “b” through “d.” 

b. Click the Start button, and then click Run. 

c. Type <drive>:launch.  For example, if your CD-ROM drive is drive D, 
type d:launch. 

d. Follow the browser instructions on your screen. 

1.5 Enabling the Section-By-Section Option 
Before you can collect data, you must enable the SxS option. 

a. Start SxS by clicking the Section-By-Section icon on your desktop. 

b. On the Configure menu, click Add/Remove Option. 

c. Enter the ADCP serial number. 

d. Enter the Key code. 

e. Click the Add ADCP button. 

f. Click OK. 

 
Figure 1. Enabling the Section-By-Section Option 
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2 Overview of WinRiver II SxS 
This section includes a brief overview of the inputs, displays, and outputs 
provided by WinRiver II SxS. 

ADCP

StreamPro ADCP Via Bluetooth

Inputs OutputsDisplays

Serial Port COM 1

Measurement File (*.mmt)
Field Configuration

Playback Configuration
QA/QC

Sections
Raw ADCP Data (*.PD0)

Support Files
Section Discharge Summary

 
Figure 2. Overview of WinRiver II Section-By-Section 

2.1 Comparison of WinRiver II and SxS 
You will notice several similarities between WinRiver II and Section-By-
Section and also several differences.  

• Many of the displays are similar but some are unique to Section-
By-Section.  Note that when you are in Section-By-Section, the 
title bar at the top of the display is Section-By-Section.  This 
makes it easy to see which program is running.   

• In WinRiver II, the transect is done by crossing from bank to 
bank of the river.  In Section-By-Section, transects are done by 
measuring at different user selected points on the river.  This 
makes it possible to measure streams that are frozen over.  This 
makes the Discharge Summary display different.  WinRiver II 
shows the history of the entire transect; Section-By-Section 
shows the history of each section measured. 

• Measurement files are different between WinRiver II and Sec-
tion-By-Section.  Use the proper program to play back data.  A 
measurement data file created with Section-By-Section can not 
be used to play back data using WinRiver II.   

• WinRiver II uses Bottom Tracking or GPS for velocity reference 
and Section-By-Section does not.  This makes it possible to use 
Section-By-Section software to measure discharge in streams 
with moving beds.   
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2.2 Inputs 
In order to use WinRiver II SxS, your Workhorse ADCP must meet the fol-
lowing criteria. 

• WorkHorse Rio Grande ADCP or the WorkHorse ADCP must 
have the Bottom Track upgrade installed 

 

NOTE.  The Bottom Track and High Resolution Water Modes upgrades are 
available for WorkHorse Monitor and Sentinel ADCPs (included with the 
Rio Grande ADCP).  This guide assumes you will be using a WorkHorse 
Rio Grande ADCP. 

The Rio Grande, Monitor / Sentinel, and Mariner ADCPs can benefit from 
the upgrade to the High Rate Pinging (Water Mode 12) and Shallow 
Bottom Mode (Bottom Mode 7).  Contact your local sales representative if 
you are interested in upgrading your system. 

 

• WinRiver II SxS can also be used with a StreamPro ADCP if your 
computer has a Bluetooth connection.   

ADCP Mounting Requirements 

The ADCP must be mounted as follows. 
• Over the side or through the hull mounted 

• Downward facing 

• Within 5 degrees of vertical (see note) 

TRDI recommends using a fixed mount to achieve the best performance 
(see the WorkHorse Technical Manual for recommended sources of 
mounts). 

 

NOTE.  See the WorkHorse Commands and Output Data Format Guide for 
details on how the ADCP uses tilts in transformation (see the EX 
command).   

 

2.3 Displays 
All of the WinRiver II SxS displays may be saved to files or printed.  For 
more information, see “Available Displays,” page 22 and “Print a Graph or 
Display,” page 58.   

2.4 Outputs 
The “heart” of WinRiver II SxS is the measurement file (*.mmt).  A meas-
urement file is created by running the Measurement Wizard (see “Using 
the Measurement Wizard,” page 29).  The Measurement Control window 
helps keep track of the files used in the measurement and provides a quick 
way to access program controls by right-clicking on items in the list.  For 
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more information about the measurement control window, see “Using the 
Measurement Control Window,” page 15.   
Measurement File 

• Configuration information – The Field Configuration for each meas-
urement contains the settings used to collect the data.  No changes can 
be made to this information once a measurement has started.  A Play-
back Configuration is created when a measurement is reprocessed (see 
“Post-Processing of Discharge Data,” page 54). 

• QA/QC information (ADCP tests, etc.) 

• The Measurement Control window shows a list of all the measurement 
and support files.   

Sections 

• Raw ADCP data files (*.PD0) – These files contain all data sent from 
the ADCP during data collection.  Refer to the WorkHorse Commands 
and Output Data Format guide for a complete description of the format 
of raw ADCP data files.  For any specific deployment, raw data files 
contain the most information and are usually the largest.   

Each time you start a section (using the Acquire menu or the shortcut 
key F5), WinRiver II SxS adds a section node to the Measurement 
Control window and opens a new *.PDO raw data file.  The section 
number is incremented for each section.  For more information on how 
to collect data, see “Acquiring Discharge Data,” page 48.   

The raw ADCP data files are saved to the same folder as the measure-
ment file.  Other TRDI software like RDI Tools may be used with the 
data files as needed.  For more information about the format of the of 
raw ADCP data, see the WorkHorse commands and Output Data For-
mat guide. 

 

CAUTION.  TRDI’s software WinADCP is not compatible for viewing 
and/or exporting WinRiver II SxS data, or data collected in Ship or 
Instrument coordinates.  Using WinADCP to display and/or export 
WinRiver II SxS data results in an incorrect naming structure.  Data is 
called Earth coordinates when it is actually Ship coordinates.   

 
Q Measurement Summary 

• The Q Measurement Summary is a printed report of the discharge.  
See “Using the Q Measurement Summary,” page 60 for more informa-
tion.   
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3 Communications Setup 
When WinRiver II SxS is first started, you can set up the communications 
with the ADCP.  Once setup, WinRiver II SxS will remember the settings 
and use them each time the program is started. 

 

NOTE.  Using the Measurement Wizard (see “Using the Measurement 
Wizard,” page 29) will also prompt you to set up communications if they 
are not already configured. 

 

a. Connect and power up the ADCP as shown in the appropriate ADCP 
User’s Guide.  

b. Start WinRiver II SxS.  To open the Peripheral Configuration Dialog 
box, on the Configure menu, select Peripherals.   

 
Figure 3. Peripheral Configuration Dialog 
 

c. Click the + box next to Read Serial Raw ADCP Data to expand the list 
and then select Port: ADCP Serial Port.  Press the Configure button. 

 
 

 

NOTE.  The default baud rate for WorkHorse ADCPs is 9600.  Use the 
Advanced ADCP Communications Configuration screen (see Figure 4, 
page 8) to set the ADCP’s baud rate as high a rate as possible and 
configure SxS to match the ADCP’s baud rate. 

 

d. Select the communication port, Baudrate, Databits, Parity, and Stopbits.  
If you are unsure of the setting, click Cancel and right-click on Instru-
ment: ADCP Instrument and select Auto Detect.  Click OK to con-
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tinue.  Click Test Port to have WinRiver II SxS connect to the device 
and confirm the communication setting.   

e. Once set up, select Close to exit the Peripheral Configuration Dialog 
box. 

3.1 Advanced ADCP Communications Configuration 
Use the following steps to communicate with the ADCP or verify command 
settings. 

a. On the Configure menu, select Peripherals. 

b. Click the + box next to Read Serial Raw ADCP Data to expand the list 
and then select Instrument: ADCP Instrument.   

c. Press the Configure button. 

 

 
Figure 4. Advanced ADCP Configuration Dialog 
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d. Use the Advanced ADCP Configuration Dialog screen to send or ver-
ify command setting as needed.  Click the Send button to send the 
command to the ADCP and view the results of the command in the 
Terminal Window.  

e. Use the Send Break button to wake up the ADCP.   

f. If the command you want to send the ADCP is not on the list, type it 
next to the “>” prompt in the Terminal Window and press return. 

 

CAUTION.  Do not use this screen to deploy or configure the ADCP.  
The commands will be overwritten when Acquire, Start Pinging (F4) is 
pressed.  Only the commands generated through the wizard and sent via 
Acquire, Start Pinging (F4) can be used to deploy the ADCP.   

 

 

NOTE.  WorkHorse Monitor/Sentinel ADCPs will go to sleep if a command 
is not sent within five minutes; Use the Send Break button to wake the 
ADCP before sending a command. 

WorkHorse Rio Grande ADCPs do not sleep.  For more information, see 
the CL command in the WorkHorse Commands and Output Data Format 
guide. 

 

 
Figure 5. One Step Setup 
One Step Setup 

Use the One Step Setup to check the deployment commands sent to the 
ADCP after the Measurement Wizard has been completed.   

a. Run the Measurement Wizard (see “Using the Measurement Wizard,” 
page 29). 
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b. Click One Step Setup.  Click the Send button. 

c. If any command generates an error message, stop and correct the prob-
lem before deploying. 

 

CAUTION.  Do not use this screen to deploy or configure the ADCP.  
The commands will be overwritten when Acquire, Start Pinging (F4) is 
pressed.  Only the commands generated through the wizard and sent via 
Acquire, Start Pinging (F4) can be used to deploy the ADCP.   

 

 

NOTE.  The One Step Setup is a good way to check if any command 
generates an error message (for example, if the commands depend on the 
High Resolution Water Profiling upgrade but you are not sure the ADCP 
has this feature).   

If a command generates an error, a message box will appear. 

The One Step Setup does not check the commands for “reasonableness”.  

If the wizard has not been run, the Fixed and Wizard command boxes will 
be blank.  

Commands can be entered in the User box or at the “>” prompt. 
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4 Customizing WinRiver II SxS 
WinRiver II SxS can be customized to look and act, as you prefer.   

4.1 Workspace 
A Workspace is a collection of windows arranged and sized, as you prefer.  
To create a Workspace file, open all the windows you want to see during 
data collection or post-processing.  Open and arrange the views you are in-
terested in.  When you have the displays set up the way you prefer, on the 
File menu, click Save Workspace As.  To use a Workspace file, on the File 
menu, click Load Workspace.  How workspaces are loaded and saved 
when starting/closing WinRiver II SxS depends on the User Options (see 
“General Configuration,” page 12). 

4.2 User Options 
On the File menu, click Properties.  The Properties dialog sets how Win-
River II SxS behaves upon entering the Acquire mode and how workspace 
files are loaded or saved.  

4.2.1 Acquire Mode Properties 

 
Figure 6. User Options – Acquire Mode 
Upon Entering Acquire Mode 

• Start Pinging Immediately – Select this option if you want the 
ADCP to begin pinging as soon as the Acquire mode is started.   

• Start Recording Immediately – Select this option if you want 
the ADCP to begin recording as soon as the Acquire mode is 
started. 
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4.2.2 General Configuration 

 
Figure 7. User Options – General Configuration 
Workspace Files 

• Load Last Workspace On Startup – Select this option if you 
want the same graphs and displays opened as soon as WinRiver 
II SxS is started.   

• Auto Save Workspace On Close – Select this option if you want 
to automatically save any changes to the workspace whenever 
WinRiver II SxS is exited. 

• Save Measurement in Workspace – Select this option to in-
clude the measurement file with the workspace. 

• Load Default Screen Layout – Check this box to use the default 
workspace.   

Measurement Wizard Settings 

Check the Reset Wizard to Defaults box to have the measurement wizard 
use the default settings based on the frequency of the user’s ADCP. 
Show Data 

Check the While Loading a Raw Data File box to begin displaying data 
while the file is loading.  For smaller data files, this may not be noticeable. 
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4.3 Display Options 
The following options are available for all graphs. 

 
NOTE.  All graph scales and font sizes are user-selectable in real-time by 
right-clicking on the graph and selecting Properties. 

 

4.3.1 Changing Units 
To change the units for all displays, on the Configure menu, select Units.  
You can change units to All English, All SI or use the Advanced menu and 
select each unit for Velocity, Range/Depth, and Temperature. 

 

NOTE.  When using a StreamPro ADCP on small streams/channels, 
change the Velocity units to mm/s or cm/sec.  This will change the 
discharge to mm3/s or cm3/s. 

 

 
Figure 8. Changing the Units 
 

4.3.2 Changing the Reference 
To change the reference, on the Configure menu, select Reference.  You 
can select one of the following references.   

• Bottom Track – ADCP Bottom-Track velocity (standard 
configuration) 

• None – No reference is used. 

4.3.3 Coordinate System 
To change the coordinate system for the displays, on the Configure menu, 
select Coordinate System.  The default coordinate system is Earth for Rio 
Grande ADCPs and XYZ for StreamPro ADCPs.   
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4.3.4 Global Parameters 
To change the global parameters of the displays, select the Configure 
menu, and click Global Parameters.  This menu allows changes to the 
number of sections on the X and Y axis, the Grid Lines (visible, style, and 
color), and Background Color.  To return to the factory defaults and the de-
fault window layout, check the Reset to Factory Defaults box and select 
Apply.  Click OK to exit the screen. 

 
Figure 9. Global Parameters for Graphs 

4.3.5 Zoom Functions 
• Zoom to Extents – click the blue title bar at the top of the win-

dow to select the graph and then click the Zoom to Extents but-
ton on the toolbar ( ).  The data will be zoomed to the full 
graph width. 

• Zoom In – Click the Zoom In ( ) button on the toolbar.  The 
cursor will change to a “+” magnifying glass.  Hold down the 
left mouse button and drag over an area on the window to zoom 
in.  The chosen region will be zoomed to the full graph width. 

• Zoom Out – Click the Zoom Out ( ) button on the toolbar.  The 
cursor will change to a “-” magnifying glass.  Hold down the left 
mouse button and drag over an area on the window to zoom out.   

• Pan – Use the Pan button on the toolbar ( ) to move the graph 
data as needed. 

• Arrow – Use the Arrow button on the toolbar to identify the data 
under the cursor point.   
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5 Using the Measurement Control Window 
The Measurement Control Window gives the user a quick and easy way 
to manage the files used in a measurement.  It uses a tree structure; click the 
+ box to expand the list or – to collapse.  Right-clicking on a name will 
bring up menus to quickly access different functions.  

 
Figure 10. Measurement Control Window 

5.1 Measurement File Name 
Right-click on the measurement file name to display the following menu.  
If a measurement file is not already open, only the New Measurement, 
Create Measurement from Data Files, and Open Measurement menu 
items are available. 

 
Figure 11. Measurement Control - Measurement Menu 
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5.1.1 New Measurement 
Select New Measurement to start the Measurement Wizard (see “Using the 
Measurement Wizard,” page 29). If a measurement is already open, you will 
be prompted to save the current measurement. 

5.1.2 Create Measurement from Data Files 
Use Create Measurement from Data Files and select one data file to cre-
ate a measurement.  The file must have been collected with the StreamPro 
software with the Section-By-Section feature enabled. 

5.1.3 Save Measurement 
Use the Measurement Wizard to setup WinRiver II SxS (see “Using the 
Measurement Wizard,” page 29).  Once the Measurement Wizard is com-
pleted, on the File menu, select Save Measurement.  Enter the File name 
and select Save.  WinRiver II SxS will automatically add the file extension 
*.mmt. 

 
NOTE.  WinRiver II SxS automatically saves the measurement file each 
time you start/stop a section.   

 

5.1.4 Open Measurement 
To open a measurement file, on the File menu, select Open Measurement.  
On the Select Measurement File dialog, select the measurement file and 
click Open. 

5.1.5 Close Measurement 
To close a measurement file, on the File menu, select Close Measurement.  
On the Close Measurement Confirmation dialog, select Yes to close the 
measurement file. 

5.1.6 Lock Measurement 
Use Lock Measurement to write protect the measurement file.  If a meas-
urement file is locked, any changes made to the playback configuration 
nodes will not be saved unless the measurement file is first “unlocked”.  
This prevents accidental saving of changes made to configuration nodes 
while “experimenting” with different settings.  To lock a measurement file, 
right-click on the measurement file name and select Lock Measurement.  
To unlock a measurement file, right-click on the measurement file name 
and select Unlock Measurement.  The icon next to the measurement file 
name will change from a lock to a clipboard to let you see if it is locked or 
not. 
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5.2 Site Information 
Right-click on Site Information and select Site Wizard; this opens the 
wizard and allows changes to the Site Information (see “Site Information,” 
page 17) page of the wizard.  If changes are made, save the measurement 
file (see “Save Measurement,” page 16).   

 
Figure 12. Measurement Control - Site Information Menu 

5.3 Measurement 
Right-clicking on Measurement will display the following menu.  

 
Figure 13. Measurement Control – Transect 

5.3.1 Reprocess Measurement  
Use this function to reprocess the measurement file. 

5.3.2 Add Note 
Use this function to add a note to the measurement file for the selected tran-
sect.  For example, you may want to record a note about the instrument 
setup or factors such as wind conditions, the passage of other vessels, and 
any other noteworthy events that occur during your transect of the channel.   
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5.3.3 Data File 
Right-clicking on a data file and selecting Properties will display the Raw 
Data File Properties box.   

 
Figure 14. Measurement Control - Raw Data File Properties 
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5.4 Field and Playback Configuration Nodes 
Once you reprocess a transect (see “Reprocess Measurement ,” page 17) or 
duplicate the Field Configuration node, WinRiver II SxS creates a Play-
back Configuration node.  The Playback Configuration is a copy of the 
Field Configuration information used to collect the data.  Any editing 
changes made to the Playback Configuration are saved to the measure-
ment file.  Playback Configuration nodes can be Duplicated, Deleted, and 
Renamed as needed. 

5.4.1 Configuration Node Menu Options 
Right-clicking on a Field Configuration or Playback Configuration node 
will display the following menu. 

 
Figure 15. Managing Configuration Nodes 

5.4.2 Set as Active Configuration 
The active configuration node is in bold.  Right-click the on the configura-
tion node name and select Set as Active Configuration to change between 
configuration nodes.  Only one configuration node may be active at a time. 
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5.4.3 Configuration Wizard  
This option is only available in the Acquire mode and only if no measure-
ments have been collected.   

a. On the Acquire menu, select Stop Pinging. 

b. Right-click on the Field Configuration node and select Configuration 
Wizard; This will restart the Measurement Wizard (see “Configuration 
Dialog,” page 30). 

c. Make your adjustments. 

d. To restart, click the Acquire menu and select Start Pinging. 

 
NOTE.  Once a measurement has started, the field configuration node can 
no longer be changed. 

 

5.4.4 Properties 
Use this function to view the configuration settings (see “Configuration 
Node Properties,” page 39).  Changes to the settings are only allowed on 
Playback Configuration nodes or if data collection for the transect has not 
started.  You can view what settings were used for the Field Configuration. 

5.4.5 Reset Properties 
This resets the playback configuration node back to the same parameters as 
the field configuration node. 

5.4.6 Duplicate  
Use this function to duplicate the configuration node.  If the Field Configu-
ration node is duplicated, it will create a new Playback Configuration node. 

5.4.7 Delete 
Use this function to delete the configuration node.  The Field Configuration 
node can not be deleted. 

5.4.8 Rename 
Use this function to rename the configuration node.  The Field Configura-
tion node can not be renamed. 
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5.5 Show Summary 
Right-click on the Section Discharge Summary field and select Show 
Summary to display the discharge summary (see “Section Discharge Sum-
mary,” page 26). 

 
Figure 16. Measurement Control - Discharge Summary 
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6 Available Displays 
Use the View menu to select what graphs and tabular data to display.  Win-
River II SxS can use the following screens. 

• Measurement Control Window (see “Using the Measurement 
Control Window,” page 15) 

• Contour Graphs 

• Profile Graphs 

• Tabular Displays 

6.1 Contour Graphs 
The View, Graphs, Contour, Velocity menu lets you select the type of 
velocity contour graph to display.   

 

NOTE.  To change the graph scale, right-click on the graph and select 
Properties.   

To change what data is displayed, right-click on the graph and select Data 
Selection. 

 

The available velocity contour graphs are the four earth-referenced velocity 
components (East, North, Up, Error, Magnitude, and Direction).   

 
Figure 17. Velocity Contour Graph 
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The following are the velocity contour graph options. 

 
• East Velocity – East is positive (west is negative).   

• North Velocity – North is positive (south is negative). 

• Up Velocity – Up is positive (down is negative). 

• Error Velocity – This velocity component is a measure of “data 
reasonableness.”  There is no velocity reference for this value.  
The error velocity calculation depends on transducer orientation 
and beam pattern.  See the ADCP Technical Manual for details 
of the velocity processing algorithm. 

• Velocity Magnitude/Direction – The velocity magnitude and 
direction are clockwise with respect to North. 

Click View, Graphs, Contour, Intensity to select the echo intensity 
contour graph.   

 
Figure 18. Intensity Contour Graph 
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To change what data is displayed, right-click on the graph and select Data 
Selection.  The five intensity graphs are: Beam 1, Beam 2, Beam 3, Beam 
4, and Average.   

 

6.2 Profile Graphs 
A profile graph is a line graph of a selected parameter versus depth.  The 
View, Graphs, Profile menu lets you select the type of profile graph to 
display.   

 

NOTE.  To change the graph scale, right-click on the graph and select 
Properties.   

To change what data is displayed, right-click on the graph and select Data 
Selection. 

 

 
Figure 19. Velocity Profile Graph 
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The following profile graphs are available. 

• Intensity Profile – WinRiver II SxS displays the intensity profiles 
for all four ADCP beams.  The echo intensity units are in counts.  
Use the Intensity minimum/maximum scaling values to define 
the horizontal axes of the graph. 

• Velocity Profile – The velocity profiles show the earth-
coordinate section average velocity components (East, North, 
Up, and Error).  The velocity units can be in either m/s (SI) or 
ft/s (English).  Scaling for the top horizontal axis on the graph 
(Up Error Velocity) uses the minimum/maximum scale values of 
the Up Velocity or Error Velocity.  Similarly, the bottom horizon-
tal axis (East North Velocity) uses either the East Velocity or 
North Velocity scale values. 

• Backscatter Profile – WinRiver II SxS displays the backscatter 
profiles for all four ADCP beams.  Backscatter data is range and 
absorption normalized and the units are in decibels (dB).  Data 
are obtained from the receiver’s Received Signal Strength Indi-
cator (RSSI) circuit.  The default of Calculate for each Ping is 
used (similar to WinRiver II), but in SxS it can not be changed at 
this time. 

• Correlation Profile – WinRiver II SxS displays the correlation 
profiles for all four ADCP beams.  Correlation is a measure of 
data quality, and its output is scaled in units such that the ex-
pected correlation (given high signal/noise ratio, S/N) is 128 for 
Mode 1. 

6.3 XY Graphs 
Discharge over Distance – This XY graph displays the horizontal meas-
ured discharge and corresponding power fit versus depth.   

 
Figure 20. Discharge over Distance Graph 
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6.4 Tabular Displays 
The Tabular displays show the data for the last ensemble in tabular form.  
WinRiver II SxS displays as Bad the data flagged bad by the ADCP. 

Table  1: Available Tabular Displays 
Display Description 

Ensemble Header  The Ensemble Header display shows information about the ADCP setup. 

Composite  The Composite display lists information about the currently displayed ADCP 
data ensemble, and discharge information.   

Bottom Track  The Bottom Track display lists information about the beam depths and bottom 
track velocities. 

Velocity  Displays the earth-referenced velocity components (East, North, Up, Error) 
percent good pings for the bin, and discharge. WinRiver II SxS displays as 
bad the data flagged bad by the ADCP. 

Earth Velocity 
Magnitude & Direction 

Displays the earth-referenced velocity components (Magnitude, Direction, Up, 
Error) percent good pings for the bin, and discharge. 

Intensity  Displays the echo intensities for all four beams. 

Backscatter  Displays the echo intensities for all four beams. 

Correlation  Displays the correlation magnitudes for all four beams. 
 

 
NOTE.  During data collection, the text color will change to blue when the 
file is no longer being updated.  

 

6.5 Section Discharge Summary 
Select View, Section Discharge Summary to display the Section Dis-
charge Summary.  This screen displays detailed information and statistics 
about each section.   

 
Figure 21. Discharge Summary Screen 
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6.6 Acquire Control Window 
Select View, Acquire Data to display the Section Acquire Control window.  
This screen gives you a quick view to see if the ADCP is recording or ping-
ing. 

 
Figure 22. Section Acquire Control Window 
 

6.7 Adding Customized Graphs to the Menu 
Please note that not all available graphs are shown on the menu.  For exam-
ple, the profile graph Velocity Magnitude and Direction is not predefined 
graph.  On the View menu, select Graphs, Profile, Velocity.  Right-click 
on the velocity profile graph and select Data Selection.  Select Earth Ve-
locity Magnitude and Earth Velocity Direction and than click OK.   

 
Figure 23. Data Selection Dialog 

Once you have selected a graph and selected the data you want to see, right-
click on the graph and select Add to Menu.  Name the graph and click OK.  
The graph will now be available on the menu for future use with a click of 
the mouse button.  If you want to always see the graph when WinRiver II 
SxS starts, make sure to save the workspace by clicking File, Save Work-
space As.   
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Figure 24. Adding a Graph to the Menu 
 

 
NOTE.  There is no method to remove a graph once added to the menu 
except by re-installing WinRiver II SxS. 
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7 Using the Measurement Wizard 
WinRiver II SxS is setup to collect data using the Measurement Wizard.  
The Measurement Wizard gives the user the ability to create a Field Con-
figuration node and enter the information needed for data collection and 
correct data display during data collection.  Once setup, the measurement 
file can be saved and than later retrieved. 

a. On the File menu, click New Measurement.   

b. After each page information has been entered, click Next. 

c. After reviewing the Summary page, click the Finish button to complete 
the wizard.   

7.1 Site Information 

 
On the Site Information screen, enter the Station Data, Agency Data and 
Field Party Data information.  Each of these fields will be included on the 
Q measurement summary file (see “Using the Q Measurement Summary,” 
page 60).  

Enter the Station Data Stage (m) and Rated Q (m3/s) information.   

 

NOTE.  If a Station Name is entered, it will be used in the Filename 
Prefix box on the Output Filename Options page of the wizard (see 
“Output Filename Options,” page 34). 

Enter a Measurement Number (alphanumeric).  This can be added to the 
file name on the Output Filename Options page of the wizard. 
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7.2 Configuration Dialog 

 

7.2.1 Devices 
WinRiver II SxS will attempt to connect to the ADCP when this page opens 
or the Check ADCP button is clicked.  If the ADCP is not available or com-
munications with the ADCP have not been setup, you will see the following 
dialog box.   

 
Click Cancel to continue with the wizard, click Yes to have WinRiver II SxS 
automatically detect the ADCP, or click No to setup the communications 
yourself.   

If you see the following message box, this means WinRiver II SxS is not 
sure what type ADCP you are using.  Click OK to continue. 
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If you are using a Rio Grande ADCP, WinRiver II SxS will automatically 
detect the ADCP and enter the ADCP Serial Number, otherwise, enter the 
serial number.  The ADCP serial number will be added to the Q Measure-
ment Summary (see “Using the Q Measurement Summary,” page 60). 

7.2.2 ADCP Wizard Configuration 
Enter your choices for the ADCP Wizard Configuration section.  Based 
on the entered information, the wizard will enter commands on the 
“Commands Page,” page 39.  WinRiver II SxS will give warning messages if 
the settings are not recommended.  Click the Close button on the message 
box or continue making choices. 

 
Figure 25. Warning Message 

Max. Water Depth – Enter the expected maximum depth of the stream. 

Secondary Depth – Enter a secondary depth (optional). For example, enter 
the minimum depth at the edge. 

Max. Water Speed – Enter the expected maximum speed of the stream.  

Max. Boat Speed – Enter the expected maximum speed of the boat.  

Streambed – Enter the expected streambed material.  

Bottom Mode – Enter the bottom mode (Mode 5, Mode 7, or Auto).   

 Recommended Setting.  Use the Auto mode. 

 

Water Mode – Enter the water mode (Mode 1, Mode 5, Mode 8, Mode 11, 
Mode 12 Auto, Mode 12 Custom, or Auto).   

 Recommended Setting.  Use the Auto mode. 
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If you select Mode 12 Custom, the following screen appears.   

 
Figure 26. Water Mode 12 Options 

Bin Size (meters) – Set the desired bin size.  This will add the WK com-
mand to the Wizard section of the command page.   

Update Rate (seconds) – Increasing the Update Rate will increase the 
number of subpings.   

Time Between Subpings (100th seconds) – This set the time between sub-
pings in hundredths of a second and sets the second parameter of the WO 
command.  In the above example, the WO command would be set to 
WO13,5. 

Click the Compute button to see the Optimized Configuration conse-
quences.  Click Done to return to the Configuration Dialog screen. 

 
NOTE.  Your ADCP must have the High Rate Ping feature enabled in order 
to use Mode 12.   

 

7.2.3 Sample Time 
The default Sample Time is 40 seconds.  You may increase this if desired. 
In slow, shallow flow increasing this value will reduce the uncertainty of 
the measured velocity.   

 Recommended Setting.  Leave the Sample Time at 40 seconds. 

 

7.2.4 Measurement Angle 
If the measurement line is not perpendicular to the flow, then enter the angle 
of deviation from perpendicular in the Measurement Angle box. This will 
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reduce the discharge to compensate for the fact that each panel is wider than 
would be the case if the measurement line were perpendicular. 

7.2.5 Flow Type 
Normal is selected by default for the Flow Type.  SxS will use power ex-
trapolation at the surface and power extrapolation to the bottom. 

If the velocity profile is expected to be non-classical, wind driven at the sur-
face for example, then selecting the Bidirectional, wind driven box will 
use 3-point extrapolation at the surface and no-slip extrapolation to the bot-
tom.   

If you are measuring below ice cover, check the Ice box and enter the 
Transducer Depth from bottom of the ice cover to the center of the ADCP 
transducer faces.  SxS will use no-slip extrapolation at the surface and no-
slip extrapolation to the bottom. 

 

NOTE.  For a full description of the methods used to estimate discharge in 
the unmeasured top/bottom parts of the velocity profile, see the WinRiver II 
User’s Guide (Appendix B - Discharge Measurement Basics).   

 

 
Figure 27. Ice 

7.2.6 Offsets 
Enter your choices for the Offsets section.  For more information on these 
settings, see the “Offsets Page,” page 41. 

Transducer Depth – Enter the depth from the water surface to the ADCP 
transducer faces.  
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7.3 Output Filename Options 

 
Enter your choices for the Output Filename Options.  The Filename Pre-
fix and Output Directory are part of the Recording page (see “Recording 
Page,” page 43).   
Recording 

Enter a Filename Prefix if you did not enter one on the Site Information 
page of the measurement wizard.  The Output Directory will default to 
C:\Measurements\Station.  Click the Browse button to change the output 
directory. 

 
NOTE.  The Output Directory can not already exist – You will be 
prompted to change the Output Directory or Filename Prefix. 
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Include Filename Options 

• Check the Measurement Number box to add it to the file name. 

• Check the Sequence Number box and enter a Max File Size if 
you want to limit the size of the data file.  Once the file size has 
been reached, the sequence number will increment. 

• To add the Date/Time to the filename, check the Short (YY-
MM-DD) or Long (YY-MM-DD hhmmss) button.  Select No 
Data/Time to remove the Date/Time from the filename.   

• Select what type delimiter to use in the filename by selecting No 
Delimiter, Underscore, or Custom.  If Custom is selected, en-
ter the delimiter in the box. 

Review how the filename appears in the Filename Preview section. 

In the following example, the filename prefix is CheckPoint, the measure-
ment number is 13, the transect number is 003, the sequence number box, 
measurement number, and short date/time buttons were selected. 
C:\Measurements\CheckPoint\CheckPoint_13_003_000_07-04-09.PDO.   
               |                |     |  |   |   | 
               |                |     |  |   |   Short Data/Time 
               |                |     |  |   Sequence Number 
               |                |     |  Transect Number 
               |                |     Measurement Number 
               |                Filename Prefix 
               Output Directory 
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7.4 Commands Preview 

 
You can directly control the profiling parameters sent to the ADCP using 
the User Commands box.   

 
CAUTION.  Do not enter any commands in the User section unless you 
are fully aware of what the command does.   

 

 
NOTE.  For more information on ADCP commands, see the WorkHorse 
Commands and Output Data Format Guide.   
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7.5 Summary Page 

 
Review the summary page; use the Back button to return to previous 
pages and make any necessary changes.  If a red X appears next to the 
communication settings, it means the communications were not configured 
yet.  A green  next to the WM12 and BM7 means that the ADCP is capa-
ble of using these modes, not that the mode is selected. 

Click the Finish button to complete the wizard.   

 
NOTE.  The summary does not include consequences caused by entering 
any User commands. 

 
Measurement Characteristics  

Minimum Profile Depth (1 cell) – Shows the minimum profiling depth for 
one cell.  This depth includes the blanking distance and transducer depth. 

Minimum Profile Depth (2 cells) – Shows the minimum profiling depth 
for two cells.  This depth includes the size of bins 1 and 2, blanking dis-
tance, and the transducer depth. 

Maximum Profile Depth (meters) – Shows the maximum profiling depth 
for the settings used. 
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Horizontal Velocity Standard Deviation (Meters/second) – Not imple-
mented at this time. 

Estimated Discharge COV (1 pass) – Not implemented at this time. 

Estimated Discharge COV (4 passes) – Not implemented at this time. 

 

NOTE.  Coefficient of Variation for WinRiver II SxS is defined as (Standard 
Deviation of the average velocity for each ping)/(average velocity of all 
pings). 

Where the average velocity is the average of all good cells in the profile. 
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8 Configuration Node Properties 
This section has detailed explanations of each of the settings contained in 
the configuration node.  There are seven pages that configure different por-
tions of the configuration node. 

To view the field or playback configuration node settings, right-click on the 
configuration node on the Measurement Control window, and than select 
Properties (see “Using the Measurement Control Window,” page 15).  The 
configuration node presently in use will be in bold text. 

 

NOTE.  Changes to the Field Configuration node can only be made when 
not pinging.  If you make any changes, you must change the Filename 
Prefix or Output Directory to create a new measurement file.   

 

When creating configuration nodes for data collection, the most important 
parts in a configuration node are the Commands and Recording tabs.  Set 
them to the desired parameters.  The rest of the parameters can be changed 
during playback and do not influence data collection.   

For correct data display while acquiring data you can enter the following 
values.   

• On the Offsets page set the ADCP Transducer Depth (part of 
the Measurement Wizard).   

• On the Discharge page, if the velocity profile is expected to be 
non-classical, wind driven at the surface for example, then se-
lecting the Bidirectional, wind driven box will use 3-point ex-
trapolation at the surface and no-slip extrapolation to the bottom.   

8.1 Commands Page 
You can directly control the profiling parameters sent to the ADCP using 
the User Commands box.  The ADCP Technical Manual explains all direct 
commands in detail.  The Fixed Commands box lets you view the direct 
commands that will always be sent to the ADCP.  The Measurement Wizard 
will enter the Wizard Commands based on information entered in the 
Measurement Wizard (see “Using the Measurement Wizard,” page 29). 

 

CAUTION.  The fixed commands are sent before any user commands.  
Sending a User Command will OVERRIDE the Fixed and Wizard 
Commands.   

 

When the data collection is first started, the commands in the Fixed Com-
mands box are sent by WinRiver II SxS to the ADCP to set its profiling pa-
rameters.  The Wizard Commands are sent next and will override some of 
the Fixed Commands.  Refer to the WorkHorse Commands and Output 
Data Format guide for more detailed information about each command. 
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Figure 28. Commands Page 

Table  2: Fixed Commands 
Command Choices Description 
CR1 Sets factory defaults This is the first command sent to the ADCP to place it in a "known" 

state. 
CF11110 Flow control CF11110 selects automatic ensemble cycling, automatic ping cycling, 

binary data output, enables serial output, and disables data recording. 
BA30 Evaluation Amplitude 

Minimum 
Sets the minimum value for valid bottom detection to 30 counts. 

BC220 Correlation Magnitude 
Minimum 

Sets minimum correlation magnitude for valid bottom track velocity data 
to 220 counts. 

BE100 Bottom Track Error 
Velocity Maximum 

Sets maximum error velocity for good bottom-track water-current data 
to 100mm/s. 

BP1 Bottom track pings The ADCP will ping 1 bottom track ping per ensemble. 
ES0 Salinity Salinity of water is set to 0 (freshwater). 
EX10111 Coordinate 

transformations 
Sets Ship coordinates, use tilts, allow three-beam solutions, and allow 
bin mapping to ON. 

TE00:00:00.00 Time per ensemble Ensemble interval is set to zero. 
TP00:00.20 Time between pings Sets the time between pings to 0.2 seconds. 
WA50 False Target Threshold 

Maximum 
Sets a false target (fish) filter to 50 counts. 

WE1500 Water Track Error 
Velocity Threshold 

Sets the maximum error velocity for good water-current data to 
1500mm/s. 

WF50 Blank after transmit Moves the location of the first depth cell 50 cm away from the 
transducer head (see Table 3, page 41). 

WM1 Water mode Sets the ADCP to Water Track mode 1. 
WN50 Number of depth cells Number of bins is set to 50 (see Table 3, page 41). 
WP1 Pings per ensemble The ADCP will ping 1 water track ping per ensemble. 
WS50 Depth cell size Bin size is set to 0.5 meters (see Table 3, page 41). 
WV170 Ambiguity velocity Sets the maximum relative radial velocity between water-current speed 

and WorkHorse speed to 170 cm/s. 
WZ005 Mode 5 Ambiguity 

Velocity 
Sets the minimum radial ambiguity for profiling Mode 5 (WM5) and 
Mode 8 (WM8) Ambiguity Velocity to 5 cm/s. 

&R20 Bottom Illumination The &R command is used to set the "Bottom Illumination". This value 
determines the size of the Bottom Track transmit pulse in relation to the 
Depth.  &R is entered in percent.  If you were bottom tracking in 100m 
of water and had &R=20, the Bottom Track transmit pulse would be 
20% of 100m, or 20m.  If &R=30, then the transmit pulse would be 
30m.  

 

 
NOTE.  The above commands are shown for example only.  They are valid 
for a 1200 kHz Rio Grande ADCP using the default settings for the wizard. 
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Table  3: Wizard Commands 
Command Choices Description 
EX11111 Coordinate 

transformations 
Sets Earth coordinates, use tilts, allow three-beam solutions, and 
allow bin mapping to ON. 

TPxx:xx.xx Time between pings Sets the time between pings. 

BXxxx Maximum Bottom 
Search 

Limits how far the ADCP will search for the bottom 

BMx Bottom Mode Sets the Bottom Mode 

WFxx Blank after transmit Moves the location of the first depth cell away from the transducer 
head. 

WZx Mode 5 Ambiguity 
Velocity 

Sets the minimum radial ambiguity for profiling Mode 5 (WM5) and 
Mode 8 (WM8) Ambiguity Velocity. 

WNxxx Depth cell number Based on the maximum water depth entered in the Configuration 
Wizard, WinRiver II SxS will set the depth cell size and number of 
depth cells.  

WSxxx Depth cell size Sets the depth cell size 

WMx Water Mode Sets the Water Mode 

 

 

NOTE.  The values for the Wizard Commands are based on information 
entered in the Measurement Wizard (see “Using the Measurement 
Wizard,” page 29). 

 

8.2 Offsets Page 
The Offsets page lets you set system alignment offsets that only affect the 
displays, not the raw data files.  WinRiver II SxS saves these settings in the 
configuration node.  

 
Figure 29. Offsets Page 

Use the ADCP Transducer Depth field to set the depth from the water sur-
face to the ADCP transducer faces.  WinRiver II SxS uses this value during 
data collection and post-processing to create the vertical depth scales on all 
displays. WinRiver II SxS also uses the depth value to estimate the unmeas-
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ured discharge at the top part of the velocity profile.  Therefore, depth af-
fects the estimate of total discharge on the data collection and post-
processing displays.  The depth value does not affect raw data, so you can 
use different values during post-processing to refine the vertical graph 
scales and discharge estimates. 

 

NOTE.  The ADCP’s ED-command (Depth of Transducer) is used for 
internal ADCP speed of sound processing and is stored in the raw ADCP 
file leader.  The ED-command has no effect on the vertical depth scales in 
WinRiver II SxS.  For normal transect work, do not add an ED-
command to the Commands page (see “Commands Page,” page 39). 

 

8.3 Discharge Page 
WinRiver II SxS uses these setting to determine what formulas and calcula-
tions will be used to determine the discharge value. 

 
Figure 30. Discharge Page 

On the Discharge page, if the velocity profile is expected to be non-
classical, wind driven at the surface for example, then selecting the Bidirec-
tional, wind driven box will use 3-point extrapolation at the surface and 
no-slip extrapolation to the bottom.   
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8.4 Recording Page 
The Recording page lists the parameters used to define where the data is 
recorded during data collection.   

 
Figure 31. Recording Page 

• Filename Prefix – WinRiver II SxS uses the Filename Prefix to 
create the data file names made during data collection.  Use the 
Output Directory field to select where the data file will be 
stored.   

During data collection, if the Filename Prefix is set to TEST, 
WinRiver II SxS creates data files with the prefix TEST 
(TEST_000_000.PD0) and stores them in the directory specified 
in the Output Directory field until the disk is full.  WinRiver II 
SxS will then stop data collection and alert you to the disk space 
problem. 

 

NOTE.  A file name can contain up to 255 characters, including spaces 
and the Filename Prefix. It cannot contain the following characters: \ / : * ? 
" < > | 

 

• Use Date/Time in Filename – Check this box if you want the 
date and time stamp to be added to the file name. 

• Maximum File Size – Select the Sequence Number box to use 
the Maximum File Size field to limit the size of a data file.  The 
default for the maximum data file size is unlimited (Sequence 
Number box is not selected).  If you set the Maximum File Size 
to 1.44, then when the size of the recorded data file reaches 1.44 
MB, the Sequence Number increments.  
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9 QA/QC 
Before taking measurements, check the following items. 

9.1 Set the ADCP Clock 
a. On the Acquire menu, click Set ADCP Clock.  

b. Click the Set Clock button to set the ADCP’s time to the GPS time (if 
available) or the PC’s time.  If necessary, set the PC's clock first. 

c. Click Close to exit the Set ADCP Clock dialog. 

 

NOTE.  The first time a transect is started, the Set ADCP Clock dialog will 
open.  StreamPro ADCP users will notice that the blue LED will blink until 
the Close button is clicked.  This is normal. 

 

 
Figure 32. Set the ADCP Clock 

9.2 Test the Pressure Sensor 
The pressure sensor test should be done with the ADCP out of the water. 

a. On the Acquire menu, click Execute Pressure Sensor Test to verify the 
ADCP’s pressure sensor is functioning properly. 

b. Click the Zero Pressure Sensor button to zero out the sensor. 

c. Click Close to exit the Pressure Sensor Calibration dialog. 

 
NOTE.  If your ADCP does not have a pressure sensor, you will see an 
error message. 
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Figure 33. Test the Pressure Sensor 

9.3 Test the ADCP 
a. On the Acquire menu, click Execute RGTest to verify the ADCP is 

functioning properly. 

b. Click the Stop PC2 button to end the PC2 test.  Click Close to exit the 
RGTest dialog. 

 

NOTE.  The tests should be run while the ADCP is in non moving water.  
Running the test in air will not harm the ADCP, but some tests may fail in 
air. 

 

 
Figure 34. Test the ADCP 
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9.4 Compass Calibration 
Use the compass calibration to calibrate a Rio Grande ADCP or a Work-
Horse Monitor/Sentinel ADCP with firmware version 16.30 or greater.   

 
NOTE.  Do not use the Compass Calibration on a StreamPro ADCP.  
StreamPro systems do not have a compass. 

 

 

NOTE.  The Rio Grande firmware has been modified to allow the 
correction of the one-cycle errors with the AF command.  WorkHorse 
ADCPs with firmware versions lower than 16.30 do not have this capability. 

 

a. Mount the Rio Grande ADCP in the boat as it will be used to acquire 
data.   

b. On the Configure menu, select Peripherals. 

c. Click the + box next to Read Serial Raw ADCP Data to expand the list 
and then select Instrument: ADCP Instrument.   

d. Press the Configure button. 

e. At the “>” prompt, type AR and press the Return key.  Type Y to return 
the Fluxgate Calibration Matrices with the factory original values. 

>AR 
Do you really want to write over the active fluxgate calibration 
   data [y or n]?Y 
 
Fluxgate Calibration Matrices Updated with Factory Original Values. 
 
> 
 

f. Click OK to exit the Advanced ADCP Configuration Dialog, than 
click Close to exit the Peripherals Configuration Dialog. 

g. On the Acquire menu, click Execute Compass Calibration.  Click on 
the Calibrate button to begin the compass calibration. 

 
Figure 35. Compass Calibration Screen 
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h. During this procedure, you will drive your boat in continuous, small cir-
cles.  You can accomplish this by adjusting the throttle to just above idle 
and steering either hard left or hard right.  You will want to reduce any 
pitch and roll effects during the turn (do not move about the boat, this 
may cause the boat to change how it sits in the water) and avoid any ac-
celerations.  If you are working on a river, you will find that you drift 
downstream as you perform the circles.  This will not affect the correc-
tion procedure. 

i. While you continue to drive the boat in circles, press any key to start the 
compass calibration.  Follow the on screen prompts. 

j. Press D for details. 
HEADING ERROR ESTIMATE FOR THE CURRENT COMPASS CALIBRATION: 
   OVERALL ERROR: 
      Peak Double + Single Cycle Error (should be < 5ø):  ñ 1.73ø 
   DETAILED ERROR SUMMARY: 
      Single Cycle Error:                                 ñ 1.70ø 
      Double Cycle Error:                                 ñ 0.42ø 
      Largest Double plus Single Cycle Error:             ñ 2.12ø 
      RMS of 3rd Order and Higher + Random Error:         ñ 0.77ø 
      Orientation:    Down 
      Average Pitch:  -0.18ø         Pitch Standard Dev:    0.37ø 
      Average Roll:    0.35ø         Roll Standard Dev:     0.45ø 
 
Successfully evaluated compass performance for the current compass calibration. 
 
Press C to display Percent Horizontal Field Components 
     Relative to Calibration or any other key to continue.... 
Calibration parameters have been updated in NRAM. 
 
> 
 

k. You can now use the Rio Grande with its corrected compass and a con-
figuration that contains the magnetic variation correction to collect dis-
charge measurement data with integrated GPS.   

9.4.1 Compass Calibration Verification 
Compass calibration verification is an automated built-in test that measures 
how well the compass is calibrated.  The procedure measures compass pa-
rameters at every 5º of rotation for a full 360º rotation.  When it has col-
lected data for all required directions, the ADCP computes and displays the 
results. 

a. On the Acquire menu, click Execute Compass Calibration.  Click on 
the Evaluate button to begin the compass verification. 

b. Rotate the ADCP slowly 360 degrees (approximately 5 degrees per sec-
ond).  Pay particular attention to the Overall Error.   

c. If the overall error is less than 2°, the compass does not require align-
ment.  You can align the compass to reduce the overall error even more 
(if desired). 

HEADING ERROR ESTIMATE FOR THE CURRENT COMPASS CALIBRATION: 
   OVERALL ERROR: 
      Peak Double + Single Cycle Error (should be < 5():  ( 1.55( 
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   DETAILED ERROR SUMMARY: 
      Single Cycle Error:                                ( 1.54( 
      Double Cycle Error:                                ( 0.07( 
      Largest Double plus Single Cycle Error:            ( 1.61( 
      RMS of 3rd Order and Higher + Random Error:        ( 0.31( 
 

10 Acquiring Discharge Data 
When data collection is started, WinRiver II SxS sends the direct commands 
from the configuration to the ADCP and controls data recording for acquisi-
tions of individual transect discharge data.  Data can be displayed in tabular, 
profile, or contour formats.  WinRiver II SxS calculates discharge as it is 
calculated in real-time and accumulated as a section is made.  

 
NOTE.  It is a good idea to test the ADCP before collecting data at a 
particular site to check the ADCP’s operation (see “QA/QC,” page 44).   

 

a. Start WinRiver II SxS and load or create a measurement file (see “Using 
the Measurement Wizard,” page 29).   

b. You may want to record a note about the instrument setup or factors 
such as wind conditions, the passage of other vessels, and any other 
noteworthy events that occur during your transect of the channel.  Right-
click Site Information on the Measurement Control window to add a 
note to the measurement file (see “Add Note,” page 17).  

c. Press F4 to start the ADCP pinging.  The Acquire Tabular window will 
now show ADCP PINGING.   

 SxS will send the commands generated by the configuration wizard to 
the ADCP.   

d. Review the Command Log to see if any error occurs.  If the command 
log closed before you finished reviewing the commands, click Config-
ure, Command Log… Scroll though the log file and make sure no 
command generated an error message. 

 In a few seconds, you will see changing values in several of the data 
windows.  The ensemble number will update, the time displayed just be-
low the ensemble number will change to show the ADCP time of each 
ensemble, the position sensors will update, and so on.  And, if you have 
the ADCP in sufficiently deep water, you will see velocity profiles on 
the graph.  WinRiver II SxS will not display meaningful data if your sys-
tem is not in water.  

 In general, after you have started the ADCP pinging, there is no reason 
to stop pinging until you are finished and ready to remove the ADCP 
from the water.  An exception would be if you were operating off of bat-
teries with limited capacity.  Then, stop pinging to conserve power.   
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NOTE.  You can let the ADCP ping even if it is not in the water.  Unlike 
many other acoustic devices, no damage to the ADCP will occur.  It is often 
useful to operate the ADCP out of the water to test the configuration, 
practice with WinRiver II SxS, or perform other tests. 

 

e. Before going forward, on the Configure menu, click Reference.  
Choose None from the list.  SxS is assuming that the ADCP is not mov-
ing.  You can always determine what velocity reference is in use by 
looking at the text lines just above and below the scales at the top and 
bottom of the graph display.  At the end of each line is an indication of 
what reference is being used.  

10.1 Measurements 
Best practices encourage collecting 20 or more sections.  Each section 
should be sized so that is has less than 5% of the total rated discharge Q.  
The following sequence must be repeated for each measurement. 

10.1.1 Starting Edge 
a. Move the ADCP to the start point of the measurement. 

b. Click the Acquire menu and select Start Measurement.  The shortcut 
key is F5. 

c. Since this is the first measurement, it will be at an edge.  Select the edge 
you will start from (Left Edge or Right Edge) and enter the position of 
the edge in the Edge of Water box.  

d. Select the Bank Edge Type from one of the following.  If the edge is 
vertical instead of sloped, enter the water depth at the edge and enter the 
correction factor.  This will be applied to the velocity measured at the 
next section and used to estimate the velocity in section 1.   

• USGS/ISO –The correction factor is equal to 1.00. 

• Triangular – The correction factor is 0.35. 

• Square – The correction factor is 0.91. 

• Coefficient – The user can enter a correction factor. 

e. Click OK to continue. 
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Figure 36. Start Measurement Dialog 
 

10.1.2 Sections 
a. Now move to the first vertical to be measured.   

b. Enter the position of the Current Station.  

c. Click OK to continue. 

 
Figure 37. Pre Measurement Dialog 
 

d. Now the data will be recorded.  The Duration near the center of the 
Composite Tabular 1 screen will count up to the time remaining in the 
measurement interval (default 40 seconds).  

 As the ADCP pings, the Average Velocity of all of the pings is dis-
played as well as the Coefficient of Variation of all of the pings to that 
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time.  The Coefficient of Variation should slowly decrease and reach a 
relatively stable value.  The depth of the water is also displayed along 
with the number of seconds that have elapsed since pinging began.   

e. When the measurement interval has expired, the Post Measurement 
Dialog will appear giving a summary of the data for that station.  The 
discharge calculated for that panel is shown followed by the percentage 
of the rated Q that is measured at this station.  

 If the discharge for the station is more than 5% of the rated Q, these val-
ues will be show in red text; otherwise, they will be shown in black text.   

f. If you are satisfied with the results for this station, click Accept Data. If 
you want to repeat the station or if you want to change the position be-
fore repeating, click the Reject and Repeat button.   

 
Figure 38. Post Measurement Dialog 

g. Move to the next station. 

h. Press F5 to start the measurement. 

i. Wait for the data to be collected. 

j. If you are satisfied with the results for this station, click Accept Data. 

k. Repeat steps “g” through “j” and collect 20 sections. 
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10.1.3 Ending Edge 
a. Check the Edge box when you reach the last measurement position.   

 
Figure 39. Edge Selected 
 

b. Click Yes to finish the measurement. 

c. The selected edge will be the opposite edge from the one you selected at 
the beginning.   

d. Enter the position of the final edge.  If this edge is a vertical wall, then 
also enter the depth and the appropriate correction factor.  

e. Click OK. 

 
Figure 40. End Measurement Dialog 
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10.2 Data Collections Tips 
• Check the Edge box (Left or Right Edge) for the first and last 

sections and enter the distance of the edge of the water.  If the 
edge is vertical instead of sloped, enter the Edge Depth and en-
ter the Correction factor.   

• Minimize the ADCP movement while section measurements are 
recorded. 

• Collect 20 or more sections.   

• TRDI suggests doing a quick survey of the stream using the 
WinRiver II software to get a value for the rated Q, if it is not 
known for the site.  

• Each section should be sized so that is has less than 5% of the to-
tal rated discharge Q. 

• Station distances can count up (1.5 meters, next station 2.0 me-
ters) or down (2.0 meters, next station 1.5 meters) as necessary. 
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Figure 41. Overview of Data Collection 
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11 Post-Processing of Discharge Data 
WinRiver II SxS is used for post-processing data to get a total discharge 
value for the channel (see “Using the Q Measurement Summary,” page 60).  
After collecting 20 sections on the water body, each station must be verified 
to be within 5% of the mean discharge calculated for the set.  If any of the 
stations are outside of the tolerance, additional measurements should be 
taken. 

11.1 Playback a Data File 
a. Start WinRiver II SxS.  

b. On the File menu click Open Measurement…  

c. Select the measurement file (*.mmt) to be played and click Open.   

d. To playback a measurement file, right-click on the measurement file and 
select Reprocess Measurement.  This will create a copy of the Field 
Configuration node and creates a Playback Configuration node.  The 
data files will automatically play to the end of the file. 

 
Figure 42. Reprocess Measurement 
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11.2 Playback Older Data Files 
Use the following procedure to playback a data file created using the 
StreamPro version of SxS.   

a. Start WinRiver II SxS.  On the File menu click Create Measurement 
from Data Files and select a data file to be played.  WinRiver II SxS 
automatically reads the *.xml configuration file and create the Field 
Configuration node. 

b. To open a workspace file, click File, Load Workspace.  

c. On the Measurement Control window, right-click on the measurement 
file and select Reprocess Measurement.  The playback tool bar has 
functions to start, stop, rewind, and go to the end of the data file. 

d. Use the Measurement Control window to see what files are in use (see 
“Using the Measurement Control Window,” page 15).   

e. Play back the individual data files with their associated configuration 
nodes.  After playing through the data file, press View, Section Dis-
charge Summary or by using the shortcut key F12 to obtain the total 
discharge for each measurement.   

 The section discharge summary shows all recent sections that have been 
made and all relevant information on them.  It can be used after data col-
lection and during playback and is very effective at establishing whether 
a measurement is good or not.  

 
NOTE.  As a standard for all ADCP users it is widely accepted that 
sections should be within 5% of each other assuming constant stage. 

 

11.3 Playback Data Display Options 
The Playback data display options are the same as those for data collection.   

a. On the Playback menu, click First Ensemble to go to the beginning of 
the data file.  Click Play to review the data.  To quickly play through the 
data, on the Playback menu, select Slider or drag the ensemble marker 
on the contour graph. 

b. Right-click the display and select Properties to change the scaling fields 
of the different data displays.   

c. Use the toolbar to zoom in on (see “Zoom Functions,” page 14).   
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11.4 Editing an Item During Playback 
Some of the parameters in the Playback Configuration can be changed 
while playing back data.  The parameters that controlled data collection 
(Recording and Commands pages) can not be changed.   

Example – Data was collected using an ADCP depth of 0.06 meters.  The 
correct ADCP depth was 0.0500 meters.   

a. Open the measurement file. 

b. On the Measurement Control window, right-click on the Playback 
configuration node and select Properties.  

 
c. Select the Offsets page.   

d. Enter the correct depth.   

e. Click OK. 

f. The data file will play automatically.   

 

NOTE.  To return the all values to the parameters as collected, on the 
Measurement Control window, right-click on Playback Configuration 
and select Reset Properties.   
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Change Section Angle 

 
a. Open the measurement file. 

b. On the Measurement Control window, right-click on a section node 
and select Properties.  

c. If the measurement line was not perpendicular to the flow, then enter the 
angle of deviation from perpendicular in the Section Flow Angle box 
(see “Measurement Angle,” page 32). This needs to be done for each 
section.   

Change Edge Shape 

 
a. Open the measurement file. 

b. On the Measurement Control window, right-click on the edge node 
and select Properties.  

c. Select the Bank Edge Shape (see “Starting Edge,” page 49 and “Ending 
Edge,” page 52).     
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11.5 Print a Graph or Display 
a. Start WinRiver II SxS and open a measurement file.   

b. Click on the graph/display to be printed.  The title bar will be high-
lighted.   

c. On the File menu, click Print Setup.  Select the desired setting and 
printer.   

 
NOTE.  Choose Landscape for contour graphs. 

 

d. On the File menu click Print Preview.  If the display is acceptable, 
click Print. 

11.6 Capture Setup 
If you would like to save a graph/display for use in other documents, do the 
following. 

a. Click on the graph/display to be saved.  The title bar will be highlighted. 

b. On the Configure menu, select Capture Setup.  This will bring up a 
following dialog box. 

 
Figure 43. Capture Setup 

c. Select Clipboard or File. 

d. Select Full Screen, Window, or Client Area.  The Client Area will in-
clude all parts of the graph/plot except the title bars. 

e. Click Capture Now.  If you selected File, name the file and click Save. 
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11.7 Export Data 
The Section Discharge Summary data can be exported. 

a. Right-click the Section Discharge Summary display and select Export 
to CSV to export a comma delimited file able to be used in spreadsheets 
and other programs.   

b. Select Copy to copy the text to the Windows® clipboard as tabular de-
limited text.   

c. Use the Properties function to change the type font used for the text. 

 
Figure 44. Section Discharge Summary 
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11.8 Using the Q Measurement Summary 
The Q Measurement Summary creates a summary of the measurement that 
can be printed.   

a. Start WinRiver II SxS and open a measurement file.   

b. Playback / Reprocess the measurement (see “Reprocess Measurement ,” 
page 17).   

c. Check/edit the Site Information by right-clicking on Site Information 
in the Section Project Control window and selecting Site Wizard. 

d. On the File menu, click Print Preview Q Measurement Summary. 

e. On the Q Measurements screen, click Print to print a copy of the dis-
charge summary. 

 
Figure 45. Q Measurement Summary 
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12 Shortcut Keys 
Use the shortcut keys to quickly perform tasks.   

Table  4: WinRiver II SxS Shortcut Keys 
Key Description 
F1 Help 
F4 Start/Stop Pinging  
F5 Start/Stop Measurement  
F7 Properties 
F8 Toggle Bank  
F9 Toggle Ensemble Header Tabular view  
F11 Toggle Detailed Discharge/Composite Tabular view 
F12 Toggle Discharge Summary Tabular view 
Ctrl-A Set as Active Configuration (when Measurement Control window selected) 
Ctrl-B Reference - Bottom Track  
Ctrl-C Copy 
Ctrl-D Toggle Acquire Control window 
Ctrl-E Close Measurement File 
Ctrl-F Create Measurement from Data Files 
Ctrl-F2 Apply to All Active Configurations 
Ctrl-F3 Toggle Measurement Management window (when selected) 
Ctrl-F5 Reprocess Measurement  
Ctrl-F7 Properties (when window or file selected) 
Ctrl-F8 Data Selection (when Profile or Contour plot selected) 
Ctrl-U Duplicate Configuration node (when Measurement Control window selected) 
Ctrl-T Delete Configuration node (when Measurement Control window selected) 
Ctrl-T Export to CVS (When Discharge Summary selected) 
Ctrl-J Rename Configuration node (when Measurement Control window selected) 
Ctrl-R Reset Configuration node Properties (when Measurement Control window selected) 
Ctrl-I Site Wizard 
Ctrl-K Add Note (when Measurement Control window selected) 
Ctrl-L Lock/Unlock Measurement File  
Ctrl-M View Command Log  
Ctrl-N Reference - None 
Ctrl-O Open measurement file  
Ctrl-P Print  
Ctrl-S Save Measurement File 
Ctrl-W New Measurement 
Shift-F4 Set ADCP Clock  
Shift-F8 Execute RGTest  
Shift-F9 Execute Pressure Sensor Test  
Shift-F10 Execute Compass Calibration  
Minus Previous Ensemble (Playback) 
Space Next Ensemble (Playback) 
Ctrl-Minus Previous Section (Playback) 
Ctrl-Space Next Section (Playback) 
Home First Ensemble (Playback) 
End Last Ensemble (Playback) 
 



WinRiver II Section-By-Section User's Guide 

page 62 Teledyne RD Instruments 

13 Software History 
Version 2.00 

• Initial release. 

Version 2.01 

• Added capability to reprocess with different section angles than 
the data was collected.  

• Changed layout of Composite Tabular display. 
• Changed behavior after re-processing so the program re-positions 

to ensemble/section selected by the user.  
• Fixed problem with calculating mean velocity during acquire af-

ter changing IP Distance. 
• Fixed problem with discharge not being updated after changing 

velocity reference.  
• Fixed value of “Distance from IP” in CSV file.  
• Fixed value of “Total_Width” in CSV file when saving file in 

English units.  
• Fixed problem with “SxS Report” not being updated with some 

values from Site Information page.  
• Changed resolution of "Correction Factor" on "Section Proper-

ties" dialog.  
• Removed “Transect Number” from the wizard.  
• Fixed problem with decoding some values from StreamPro XML 

file.  
• Changed auto-scaling of "Section Contour" graph so section and 

ensemble velocity are scaled the same. 
• Fixed “Bottom Q” value on section contour graph.  
• On the "Section Properties" dialog added display of the "Edge 

Shape".  
• Added pre-filling of some Acquire Wizard fields. 
• Fixed problem updating Composite Tabular when Flow Type was 

changed. 
• Fixed problem handling poor bi-directional flow type data set.  
• Fixed problem in Section Properties Dialog: Acquisition interval 

was always 40 sec. 
• Fixed problem with bad distance value in “Section Discharge 

Summary” if section was rejected. 
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NOTES 
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